Automation of Accounting Processes

American Gas Association
Accounting Principles Committee
Hyatt Regency Lake Tahoe
August 14, 2017
Digital Labor Overview and Classes
The digital labor revolution

• Research from McKinsey suggests that as many as 45 percent of the activities individuals are paid to perform can be automated by adapting currently available digital labor technologies.

• Analysts suggest the adoption of these technologies could improve productivity by 30%.

• The development of these technologies has been driven by significant advancements in machine intelligence, digital engagement, analytics, big data, social, mobile and cloud.

• These technologies have become increasingly affordable, and the opportunities they present are high on the radar of C-suite executives.
The shift to digital labor

Global market for robots and artificial intelligence (AI) is expected to reach $152.7 billion by 2020, according to Bank of America.

MarketsandMarkets research estimates the AI marketplace will generate revenue of $12.5 billion by 2019.

According to Quid, from 2010 to 2014, private investment in AI has grown from $1.7 billion to $14.9 billion.

Top 5 smart machines will be a top five investment priority for more than 30% of CIOs, according to Gartner research.

McKinsey research suggests that smart robots will replace more than 120 million knowledge workers by 2025.
Key benefits of digital labor and robotic process automation

<table>
<thead>
<tr>
<th>Quantitative</th>
<th>Qualitative</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Cost efficiency</strong> – Estimates have found that software robots cost about one third as much as an offshore employee and as little as one fifth of an onshore employee.</td>
<td><strong>Productivity/performance</strong> – Bots work 24/7 and do not take vacations, call in sick, or require breaks. They perform at their peak all the time.</td>
</tr>
<tr>
<td><strong>Smaller facilities and infrastructure footprint</strong> – bots do not require cubicles, desks, PCs, restrooms, break rooms, or telephones, significantly reducing the facilities and infrastructure footprint.</td>
<td><strong>Scalability</strong> – Bots can scale up or down automatically and respond instantaneously to changes in demand and/or in business growth without human intervention.</td>
</tr>
<tr>
<td><strong>Quality/reliability/consistency</strong> – Bots always perform as commanded and are 100% accurate, eliminating human error. They consistently perform their tasks the same way every time.</td>
<td><strong>Auditability</strong> – Bots log all of their activities so there is always a record of what they did and what the outcome was, providing an audit trail.</td>
</tr>
<tr>
<td><strong>Employee satisfaction</strong> – Bots free up humans from performing mundane, routine work and allow them to take on higher value, more fulfilling work that results in higher job satisfaction and morale.</td>
<td><strong>Process digitization</strong> – Bots are constantly generating data about process and make tribal knowledge repeatable while providing opportunities for continuous process optimization.</td>
</tr>
</tbody>
</table>
The 3 classes of digital labor

01 Basic process automation
- Rules engine
- Screen scraping
- Work flow
- Macro-based applets
- Screen scraping data collection
- Work flow
- Visio-type building blocks
- Process mapping
- Business process management

02 Enhanced process automation
- Built-in knowledge repository
- Learning capabilities
- Ability to work with unstructured data
- Pattern recognition
- Reading source data manuals

03 Cognitive platforms
- Artificial intelligence
- Natural language recognition and processing
- Self-optimization/self-learning
- Digestion of super data sets
- Predictive analytics/hypothesis generation
- Evidence-based learning

© 2016 KPMG LLP, a Delaware limited liability partnership and the U.S. member firm of the KPMG network of independent member firms affiliated with KPMG International Cooperative (“KPMG International”), a Swiss entity. All rights reserved. N0PSS 569276
Understanding how the elements work

**Rules**
- Basic process automation
- Automation of transactional rules based tasks
- Autonomous task completion
- Tools reside at the end user layer
- Easy to design, test, and implement
- Low levels of investment

**Learning**
- Machine learning
- More advanced technologies enable the use of structured and unstructured data to support elements of self learning
- Captures tacit process knowledge and applies this knowledge to instruct how the process should run
- Generates defined process outcomes
- Speeds up human analysis to drive the right decision

**Reasoning**
- Cognitive automation
- Decision support and advanced algorithms allow automation of processes that are more cognitive in nature
- Solutions incorporate advanced self learning capabilities
- Can be used for sophisticated cognitive hypothesis generation/advanced predictive analytics
- Costly to develop and implement
- Reduces human error but does not take human out of the equation

**Characteristics**
- Transactional acceleration
- Intelligence augmentation to support right decisions faster

**Example**
- Blue Prism has automated tier – 1 inquiries (i.e., address change) for a U.S.-based online bank
- IPSOft’s Amelia utilizes AI and advanced semantic reasoning to rapidly understand questions, provide customers with answers and escalate to humans if needed.
- Firms are leveraging IBM Watson’s sophisticated ontologies, natural language processing, machine learning, pattern recognition and probabilistic reasoning algorithms to aid skilled employees and robots with complex decisions.
Identifying basic automation opportunities

Digital labor can perform work faster and more efficiently than the current manual effort. When evaluating areas of finance for Robotics Process Automation (RPA), identify finance and accounting transactional activities that meet the following criteria:

- **Rules Based**
- **High Volume**
- **Transactional**
- **Repeatable**
- **Structured Data**
Identifying cognitive automation opportunities

Cognitive automation can be used to transform complex tasks requiring highly skilled human labor to be performed by digital labor. In general building Cognitive Automation will require more time and effort. When evaluating areas of finance for cognitive automation, identify finance and accounting activities that meet the following criteria:
Digital labor software providers - examples

01 Rules
- Basic Process Automation

02 Learning
- Machine Learning

03 Reasoning
- Cognitive Analytics

Transactional acceleration ➔ Intelligence augmentation to support right decisions faster

Providers
- Redwood
- Automation Anywhere
- Blue prism
- UI Path
- Interactive Media
- IPSoft
- Arago
- Automation Anywhere
- TCS
- Wipro
- IBM Watson
- WIPRO Holmes
- Google (Deep Mind)
- A.Xi
- IPSoft
- Next IT (Alme)
- Chelation
From data to analytics for business insight

Combining data of different types from different sources allows analytics to produce new business insights, such as areas for intelligent labor augmentation.

- Financial data
- Performance data
- Unstructured data
- Audio
Digital process excellence maturity model

Work is characterized as repeatable, high volume operational tasks

*Robotics and automation tools are the force multipliers*

Work is characterized as rule based activities that require come level of judgement and interpretation

*Combination of cognitive and robotics (intelligent automation) are the force multipliers*

Work is characterized as judgement oriented activities which require a large body of knowledge and nuanced expertise

*Cognitive analytics, machine learning and robotics are the force multipliers*
Automation Opportunities for Accounting & Finance
How does robotics impact A&F?

What is the Opportunity for A&F?
Develop strategy and vision for the Finance target operating model to integrate automation and achieve higher efficiency of the finance organization and a significant reduction in OpEx.

Potential Impacts to the A&F Organizations:
— Results in higher quality of data
— Improved compliance opportunities
— Increases efficiency, speed, responsiveness and productivity
— Increases control over processes and data integrity
— Reallocates talent pool
— Provides significant cost savings opportunities as described below:

01 Rules

Basic process automation

Rules & machine learning
Helps move finance and accounting resources from performing highly manual, repetitive tasks to work on higher value areas which require analytical thinking

02 Learning

Enhanced process automation

Cognitive automation:
Further shifts finance and accounting resources to perform highly skilled tasks as automation can handle more complex activities using unstructured data

03 Reasoning

Cognitive automation:
Benefits of digital labor for A&F

**Privacy & compliance**
- Limit human exposure to sensitive corporate data
- Reduce human error in compliance tasks and potential for penalties
- Increase security & governance tasks without adding new human labor
- Audit trail

**Quality & accuracy**
- Reduce quality issues associated with manual data entry
- Deploy new “no – labor” data integrity routines
- Reduce the need for re-work

**Process improvement & efficiency**
- Leverage digitized process data to increase visibility & continuous improvement
- Enable resources to focus on higher value-added activities
- Lowers cost & risk associated with employee turnover

**Speed**
- Can perform tasks 365 days a year at 24/7 availability
- Accelerate completion rates certain tasks, compared to human labor
- Rapidly scale up/scale down for changes in transaction volumes

**Cost reduction**
- Enable opportunity to better manage labor costs
- Decouple correlation between labor and revenue growth
- Reduce need for seasonal labor force (during busy seasons etc.)

© 2016 KPMG LLP, a Delaware limited liability partnership and the U.S. member firm of the KPMG network of independent member firms affiliated with KPMG International Cooperative (“KPMG International”), a Swiss entity. All rights reserved. N09PS 569276
Key automation opportunities key insights

Key Automation Opportunities highlighted below are based on the Level 2 processes with the highest potential % reduction in FTEs. These opportunities may provide significant cost savings opportunities for the finance organization. The details for these opportunities can be provided.

<table>
<thead>
<tr>
<th>ID</th>
<th>Process area</th>
<th>Process</th>
<th>% Reduction in FTEs*</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Record to Report</td>
<td>Month End Reporting</td>
<td>50%</td>
</tr>
<tr>
<td>2</td>
<td>Record to Report</td>
<td>Manage Process</td>
<td>40%</td>
</tr>
<tr>
<td>3</td>
<td>Record to Report</td>
<td>General Ledger Close</td>
<td>50%</td>
</tr>
<tr>
<td>4</td>
<td>Source to Pay</td>
<td>Requisition &amp; Procurement</td>
<td>16%</td>
</tr>
<tr>
<td>5</td>
<td>Source to Pay</td>
<td>Purchasing</td>
<td>16%</td>
</tr>
<tr>
<td>6</td>
<td>Source to Pay</td>
<td>Supplier Management</td>
<td>26%</td>
</tr>
<tr>
<td>7</td>
<td>Source to Pay</td>
<td>Receiving &amp; Storage</td>
<td>55%</td>
</tr>
<tr>
<td>8</td>
<td>Plan to Perform</td>
<td>Performance Reporting</td>
<td>37%</td>
</tr>
</tbody>
</table>

*FTE Estimates are based on percentage of activity that can be automated and cost benchmarks for organizations with market cap in excess of $20 billion. The key automation opportunities are for discussion purposes. Actual FTE values will vary by organization dependent on company’s operational size, complexity, current resourcing mix, level of outsourcing, and technology enhancements. KPMG can assist companies to identify specific opportunity estimates.
Relative strength of RPA opportunities in Accounting based on cost benefit

- Record to report: High
- Order to cash: High
- Acquire to retire: Medium high
- Procure to pay: Medium low
- Plan to perform: Low
Potential R2R process automation opportunities

Level 2 Process Group

1.0 Close & Reconcile Subsidiary Ledgers

2.0 General Ledger Close

3.0 Preliminary Financial Statements

4.0 Financial Consolidation

5.0 Month-End Reporting

6.0 Technical Accounting

7.0 Manage Process

8.0 System Maintenance

Level 3 Process

1.1 Close/Cut-off transaction processing

2.1 Process journal entries

3.1 Review trial balance

4.1 Transfer & reconcile to the consolidation system

5.1 Prepare consolidated financial statements

6.1 Perform Accounting Research

7.1 Develop close calendar & monitoring process

8.1 Maintain System Interfaces

1.2 Close transaction systems subsidiary ledgers

2.2 Process Allocations

3.2 Review preliminary financial statements

4.2 Process currency translations

5.2 Prepare & distribute management reporting

6.2 Scan external environment and engage standards setters

7.2 Develop close policies, procedures, standards & templates

8.2 Maintain Chart of accounts

1.3 Transfer sub-ledger data to general ledger

2.3 Process local tax calculations and journal entries

3.3 Process Management & Corporate Adjustments

4.3 Process Intercompany Eliminations

5.3 Executive and external reporting

6.3 Develop Accounting Issue Identification & Monitoring

7.3 Develop & maintain internal controls

8.3 Manage business rules and Master Data

1.4 Reconcile sub-ledgers to general ledger

2.4 Perform reconciliations

3.4 Perform Financial Close Analysis

4.4 Process consolidated adjustments

5.4 Prepare Notes to the Financials

6.4 Disclosure Management

7.4 Issues tracking & resolution

8.4 Perform System Updates

Legend

Rule-Based Automation

Machine Learning

Cognitive Learning

Close & Reconcile Subsidiary Ledgers

General Ledger Close

Preliminary Financial Statements

Financial Consolidation

Month-End Reporting

Technical Accounting

Manage Process

System Maintenance

Legend

Cognitive Learning

Machine Learning

Rule-Based Automation
Sample Process Use Cases A&F
What does an RPA-based process look like?

Example - FP&A Budget Load

- Loading of Long Range Plan templates for Finance to support plan iterations
- Spans across 10 FTE's
- Approximately 300 hours across IT and Non-IT areas eligible for automation

<table>
<thead>
<tr>
<th>Process Applications</th>
<th>Key Manual Processes</th>
<th>Targeted Automated Processes</th>
</tr>
</thead>
<tbody>
<tr>
<td>- Hyperion Planning</td>
<td>- Retrieve budget data</td>
<td></td>
</tr>
<tr>
<td>- Excel</td>
<td>- Verify / validate data</td>
<td></td>
</tr>
<tr>
<td>- Email</td>
<td>- Upload budget data</td>
<td></td>
</tr>
</tbody>
</table>

BEFORE

Start → Access Files on SharePoint → Open Labor / Non-Labor Template → Log into Hyperion → Verify Data → Error → Review Errors → Upload Manually → Submit Data → Save Excel Spreadsheet → Excel Spreadsheet → End

AFTER

Start → Access Files on SharePoint → Open Labor / Non-Labor Template → Log into Hyperion → Verify Data → Ok → Submit Data → Save File in Process Folder → Close File → End

Key Manual Processes:
- Retrieve budget data
- Verify / validate data
- Upload budget data

Targeted Automated Processes:
- Retrieve budget data
- Verify / validate data
- Upload budget data

Error Handling:
- Email Team if Errors Encountered
- Review Errors
- Upload Manually

Manual Process

Automated Process

© 2016 KPMG LLP, a Delaware limited liability partnership and the U.S. member firm of the KPMG network of independent member firms affiliated with KPMG International Cooperative (“KPMG International”), a Swiss entity. All rights reserved. N00PS 569276
What does an RPA-based process look like?

Example - Blanket Order Reviews

- Audit of Capital and O&M accounting treatment for EPS Blanket Projects at Utilities
- Annual review of top 80% test year spend
- Approximately 1,500 hours spent on data compilation activities eligible for automation across OpCos

<table>
<thead>
<tr>
<th>Process Applications</th>
<th>Key Manual Processes</th>
<th>Targeted Automated Processes</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Hyperion Reporting • Excel • Email</td>
<td>• Extract report data • Data manipulation • Data formatting • Review sampling</td>
<td>• Extract report data • Data manipulation • Data formatting</td>
</tr>
</tbody>
</table>

BEFORE

- Open Excel Project File
- Run Hyperion Query
- Download Hyperion Data
- Download Hyperion Pivot Tables
- Format Review Data Tab
- Perform Data Manipulation
- Assign Review Category
- Create Sample Selection
- Review Samples
- End

AFTER

- Open Excel Project File
- Run Hyperion Query
- Download Hyperion Data
- Import Data to Excel Pivot Template
- Format and Perform Data Manipulation
- Assign Review Category
- Create Sample Selection
- Review Samples
- End
Case Studies: What Others Are Doing
Robotic process automation

KPMG client case studies

Automation strategy and assessment
$30+ billion electric utility company

Context/client challenge
- Client’s shared services finance function was looking for strategic cost cutting opportunities and interested to explore Robotics Process Automation as a transformation lever
- Select functions in the shared services organization were piloting basic automation for a limited number of high volume, high effort processes (Tax, Internal Audit, etc.)
- Transformation through traditional technology and process improvement mechanisms were often slow, with long turnaround periods
- The client asked KPMG to conduct an opportunity assessment and Proof of Concept (POC) to determine the “Size of the Prize” and to showcase the potential of process automation

Approach
- Define the strategy for the RPA program including needed capabilities to operate, manage and govern
- Conduct a detailed opportunity assessment to identify candidates for basic automation; prioritize the opportunities and determine the “Size of the Prize”
- Develop POC for select high potential use cases to prove the automation capability
- Develop implementation roadmap to institutionalize automation including capabilities required to build Center of Excellence (CoE)

Benefits
- Inventory of ~70+ automation opportunities; ~20 high potential opportunities resulting in ~15K productivity hour savings
- Developed a financial toolkit to enable client to project the expected benefits from deploying process automation; conduct sensitivity analysis for conservative and optimistic scenarios
- Defined process automation strategy for both Finance and the larger shared services organization
- Framework for setting-up an Automation COE including capabilities required to stand up program
- Conducted 2 POCs for Finance function showcasing the capabilities of basic automation
Robotic process automation

KPMG client case studies

Automation strategy and assessment
$20+ billion combination electric/gas utility company

Context/client challenge

- Client is embarking on an initiative to optimize their shared services operations and looking for changes in the way they do business by:
  - Increasing Agility
  - Delivering Efficiency
  - Building New Capabilities
- In line with their strategy, client is developing a capability in process automation which will enable the achievement of their company strategy and objectives
- Client elected a phased approach to develop the automation capability and build on progressive experience and maturity to minimize risk and increase the chances for success

Approach

- Opportunity identification: Identified RPA opportunity candidates in 4 Process Towers - Procure to Pay, Accounts Management, Credits And Collection, Billing
- Vendor Selection: Developed vendor evaluation criteria and assisted the client with the selection of RPA vendor that best suits their organization
- Business Case: Developed business case to justify RPA investments
- RPA Solution Implementation: Helped design, build and deploy automation solutions.
- CoE Design Assisted in designing and establishing the RPA CoE Org Structure and Operating Model

Benefits

- Automation opportunities are expected to deliver the following benefits
- Increase in digital agility and enable the reduction in human labor per the business case that captured a total of $6.6M in savings over 3 years.
- Improved accuracy, quality and effectiveness of processed transactions completed by bot
- Develop automated delivery capabilities with quick turn around time
- Prepare the organization to adopt and develop new solutions in new technologies in cognitive, machine learning and AI space.
- Designed and established the RPA CoE Org Structure and Operating Model
Robotic process automation

KPMG client case studies

Automation strategy and assessment
$12 billion+ combination electric/gas utility company

Context/client challenge
- Client is embarking on an initiative to optimize their shared services operations and looking for changes in the way they do business by:
  - Increasing Agility
  - Delivering Efficiency
  - Building New Capabilities
- In line with their strategy, client is developing a capability in process automation which will enable the achievement of their company strategy and objectives
- Client elected a phased approach to develop the automation capability and build on progressive experience and maturity to minimize risk and increase the chances for success

Approach
- Opportunity identification: Identified RPA opportunity candidates in 4 Process Towers - Procure to Pay, Accounts Management, Credits And Collection, Billing
- Vendor Selection: Developed vendor evaluation criteria and assisted the client with the selection of RPA vendor that best suits their organization
- Business Case: Developed business case to justify RPA investments
- RPA Solution Implementation: Helped design, build and deploy automation solutions.
- CoE Design: Assisted in designing and establishing the RPA CoE Org Structure and Operating Model

Benefits
- Automation opportunities are expected to deliver the following benefits
- Increase in digital agility and enable the reduction in human labor per the business case that captured a total of $6.6M in savings over 3 years.
- Improved accuracy, quality and effectiveness of processed transactions completed by bot
- Develop automated delivery capabilities with quick turn around time
- Prepare the organization to adopt and develop new solutions in new technologies in cognitive, machine learning and AI space.
# Robotics and Cognitive Automation

## KPMG Client Case Studies

### Automation Strategy and Assessment

<table>
<thead>
<tr>
<th>$12 billion+ Electric Company</th>
</tr>
</thead>
</table>

#### Context/Client Challenge
- Client’s customer service organization was in process of transforming customer service capabilities for front and back office to meet / exceed aggressive business objectives
- Client was looking to harness the power of automation across functions to meet cost objectives while improving capacity and quality of service delivery
- Select back office functions were piloting basic automation for a limited number of high volume, high effort processes

#### Approach
- Identify the potential productivity man-hours that could be harnessed by way of automation
- Develop a comprehensive list of automation opportunities across front and back office operations; determine the order of magnitude for the opportunity inventory
- Conduct deep dives on select high potential opportunities to develop current vs. future state maps as well as opportunity cases
- Prioritize opportunities based on impact and effort to implement to recommend select opportunities for conducting Proof of Concept (POC)
- Determine key themes across automation opportunities; identify high potential vendors for each theme
- Develop an implementation roadmap to institutionalize automation

#### Benefits
- Inventory of 25 high potential opportunities with ~216K productivity hours translating into ~$7M productivity savings annually
- Additional pipeline of 200+ automation opportunities
- Potential vendors for POC consideration for all solution themes
- Discussions underway to develop automation strategy with prioritized roadmap across organizations/functions
- Framework for setting-up an Automation COE across the identified automation themes
Getting Started
How to begin the automation journey

1. Identify and prioritize Accounting automation opportunities
2. Develop a multifaceted strategy and road map for implementing automation in the Accounting organization
3. Select the right internal team, external partners and technology providers to execute the automation journey and road map
4. Establish a Governance Strategy and Operating Model to help oversee the Accounting automation program and ensure benefits expected are realized
5. Establish a change management strategy to ensure effectiveness of adoption of automation throughout Accounting
## Typical approach

<table>
<thead>
<tr>
<th>Phase 1 (6 – 8 weeks)</th>
<th>Phase II (3 – 6 months)</th>
<th>Phase III (6 months-ongoing)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Opportunity Assessment</strong></td>
<td><strong>Pilot Implementation</strong></td>
<td><strong>Implementation</strong></td>
</tr>
<tr>
<td>— Conduct high level business process review, including business performance metrics</td>
<td>— Select automation opportunities for pilot implementation based benefits, value delivered, and complexity</td>
<td>— Begin roll out of solutions to remaining Accounting operations areas</td>
</tr>
<tr>
<td>— Develop high level business cases for automation opportunities</td>
<td>— Finalize design and requirements</td>
<td>— Implement Digital Labor governance model</td>
</tr>
<tr>
<td></td>
<td>— Demonstrate the pilot solutions</td>
<td>— Execute organizational change management plan</td>
</tr>
<tr>
<td></td>
<td>— Conduct user acceptance testing</td>
<td>— Continuously monitor and adjust solutions for maximum efficiency and effectiveness</td>
</tr>
<tr>
<td></td>
<td>— Develop the Implementation roadmap</td>
<td></td>
</tr>
</tbody>
</table>
Program governance

The Center of Excellence (CoE) provides a governance framework for building and expanding digital labor capability and driving continuous improvement throughout the organization. The governance framework addresses the following questions:

— How do we identify what should be automated in a value-centric manner?
— How do we build and deploy our digital labor capability?
— How do we manage digital labor service delivery?
— How do we scale and manage our digital labor capability going forward?
Define Operating Model

Three distinct functional groups...

<table>
<thead>
<tr>
<th>Customer (Business Units)</th>
<th>Business</th>
<th>DL CoE</th>
<th>Information Technology</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Develops and implements digital labor solutions under the guidance of the digital labor CoE.</td>
<td>Provides governance structure for building and expanding digital labor capabilities</td>
<td>Supports the business. Transforms the IT service delivery model using automation.</td>
</tr>
<tr>
<td></td>
<td>Core Competencies</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Strong business acumen and high level understanding of digital labor technologies.</td>
<td>Knowledge of digital labor technologies, market landscape, and governance requirements.</td>
<td>Technical and architectural expertise in hosting, service management and especially in the “digital” landscape.</td>
</tr>
</tbody>
</table>
Operating Model Roles and Responsibilities - Example

Each of the three RPA Operating Model Components have distinct roles and responsibilities as described below.
Organizational Change Management

To successfully incorporate digital labor within processes and teams, organizations must proactively address the impacts to their people and the overall organization in order to minimize business disruption and expedite the timing of benefits realization. Below are the most significant of these impacts.

**Organizational & People Impacts**

- **Workforce Shaping**: Adaptive workforce realignment for evolving automation needs
- **Culture Shift**: Overcoming the fear factor
- **Leadership Vision**: Agreeing on future state vision for the organization
- **Talent Management**: Hiring, reskilling and exiting talent
- **Changing Behaviors**: Adopting and adapting the new ways of working

**Unique Characteristics of Automation Implementations**

- **Speed of Implementation**: The rate of change is faster than traditional process and system implementations
- **Constant Change**: Automation implementations will be iterative and constantly evolving to develop optimal workforce productivity and ROI
## Key Change Management Considerations

### Key Considerations

The need to develop and deliver timely and effective training to the organization is a key success factor in every digital labor program. We have identified potential digital labor training components for a variety of audiences that utilize methods and media that are most suitable for the intended purpose.

<table>
<thead>
<tr>
<th>Potential Training Components</th>
<th>Audience</th>
<th>Potential Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>How to Make Robotics Digital Labor Work for You</td>
<td>Everyone</td>
<td>Comms &amp; Videos</td>
</tr>
<tr>
<td>Managing Digital Labor</td>
<td>Selected resources</td>
<td>eLearning</td>
</tr>
<tr>
<td>New Capabilities, Role and Responsibilities (Reskilling)</td>
<td>Impacted resources</td>
<td>Dependent on type</td>
</tr>
<tr>
<td>Redesign Processes and Automation Benefit Management</td>
<td>TBD</td>
<td>eLearning</td>
</tr>
<tr>
<td>How to Automate Processes</td>
<td>Selected resources</td>
<td>Instructor Led Training (ILT)</td>
</tr>
<tr>
<td>Identifying New and Evolving Existing Automation Opportunities — Campaign to generate new automation ideas or evolves existing ones through a combination of communications and training</td>
<td>Everyone</td>
<td>Communications Videos/Marketing Material Contests for Sharing Ideas</td>
</tr>
<tr>
<td>Governance Council Responsibilities and Technical Training — Overview of robotics process automation — Understanding the automation platforms, applications and components — How to automate processes and develop bots</td>
<td>Selected resources</td>
<td>ILT Shadow Training</td>
</tr>
<tr>
<td>Developing Bots/Automation</td>
<td>Selected resources</td>
<td>ILT eLearning</td>
</tr>
</tbody>
</table>
Questions and answers
KPMG Thought Leadership & Innovation

KPMG has made significant investments in people, processes, technologies, and infrastructure to ensure its global leadership in RPA thought leadership and innovation.

Digital Labor (DL) in Finance (DL supporting integrated Finance Transformation)

From software robots to sophisticated cognitive systems, advances in automation are changing the game, reducing costs by up to 75% in some financial processes, while improving speed, accuracy, business value, and control. KPMG is a leader in helping companies leverage disrupting technologies, such as DL, as a key value drive in their finance function of the future.

KPMG Digital Labor Thought Leadership

The creative CIOs’ agenda: Getting started with Digital Labor

Transforming business models with Digital Labor

The Integration of Human and Digital Labor

Capitalizing On Robotics: Driving Savings With Digital Labor

Bots in the back office: The coming wave of Digital Labor

Our Perspective

We are seeing widespread adoption of RPA technologies across our client base. However, many organizations are struggling to scale RPA after initial POCs. Most POCs are technology focused, and while we do see the initial POC bots working, organizations are realizing they are not addressing the more complex issues. Questions about how to scale, tangible cost reduction, organizational change management, risk / security, and how manage automation in production. A simple example, deploying 5 "bots" is relatively straightforward. Deploying and managing 1000 "bots" is substantially more complex. You need to connect multiple organizations to do this effectively.

Generally speaking, technology focused POCs are completely ignoring topics of governance and business value. The result is we see dozens of POCs "stalling out" because there is no automation strategy and governance approach to maximize the value. We have built an intelligent automation COE/governance framework and toolkit to help guide clients through this process, and build a roadmap for sustainable automation at scale.
Contact us

Tom Peterson
Managing Director, Advisory, Power & Utilities
T: 818-852-6131
E: tpetersonr@kpmg.com

Visit kpmg.com/us/CFOwebcasts to access the paper.

About KPMG

KPMG LLP, the Audit, Tax, and Advisory firm, is the U.S. member firm of KPMG International Cooperative (“KPMG International”). KPMG is a global network of professional firms providing Audit, Tax, and Advisory services.

We operate in 155 countries and have more than 174,000 people working in member firms around the world.

kpmg.com
The information contained herein is of a general nature and is not intended to address the circumstances of any particular individual or entity. Although we endeavor to provide accurate and timely information, there can be no guarantee that such information is accurate as of the date it is received or that it will continue to be accurate in the future. No one should act on such information without appropriate professional advice after a thorough examination of the particular situation.

© 2017 KPMG LLP, a Delaware limited liability partnership and the U.S. member firm of the KPMG network of independent member firms affiliated with KPMG International Cooperative (“KPMG International”), a Swiss entity. All rights reserved. NDPPS 643812

The KPMG name and logo are registered trademarks or trademarks of KPMG International.